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Creating Sketches in
the Sketch Mode-I
Learning Objectives
After completing this chapter you will be able to:
• Use various tools to create a geometry.
• Dimension a sketch.
• Apply constraints to a sketch.
• Modify a sketch.
• Use Modify Dimensions dialog box.
• Edit geometry of a sketch by trimming.
• Mirror a sketch.
• Use drawing display options.
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THE SKETCH MODE
Almost all models designed in Pro/ENGINEER Wildfire 2.0 consists of datums, sketched
features, and placed features. For creating datums and placed features, you do not need to
draw sketches. However, to create a three-dimensional (3D) feature, it is necessary to draw
its two-dimensional (2D) sketch. When you enter the Part mode and select the options to
create any sketched feature, the system automatically takes you to the sketcher environment.
In the sketcher environment, the sketch of the feature is created, dimensioned, and
constrained. The sketches created in the Sketch mode are stored in the .sec format. Then you
return to the Part mode to create the required feature.
Note
You will learn about datums and placed features in later chapters.
In Pro/ENGINEER, a sketch can be drawn in the Sketch mode or in the sketcher environment.
A designer can draw a 2D sketch of the product and assign the required dimensions and
constraints to it. By assigning the dimensions, the designer can make sure that the 2D sketch
of the product or model is satisfying the necessary conditions. He can then continue to create
the 3D model of the product in the Part mode.

Using the Sketch Mode
To create any section in the Sketch mode of Pro/ENGINEER Wildfire 2.0, certain basic steps
have to be followed. The following steps outline the procedure to use the Sketch mode:
1. Sketch the required section geometry
The different sketcher tools available in this mode can be used to sketch the required section
geometry.
2. Add the constraints and dimensions to the sketched section
While sketching the section geometry, weak constraints and dimensions are automatically
added to the section. The sketch can also be dimensioned and constrained manually. After
adding the dimensions you can modify them as required.
3. Add relations to the sketch if needed
The geometry of the sketch can be controlled by adding relations.
4. Regenerate the section
If the sketch is fully dimensioned and constrained, the sketch is automatically regenerated.
Throughout this book, it is assumed that you are sketching in the Sketch mode with the
Intent Manager on. Pro/ENGINEER has the capability to analyze the section, and if the
section is not complete for any reason, the section will not be regenerated. You will learn
about these reasons as you go through this chapter.
Tip: Throughout this book, sketcher environment is referred to the environment in
Pro/ENGINEER where you can draw 2D geometries. Apart from the Sketch mode,
the sketcher environment can be accessed in other modes of Pro/ENGINEER also.
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To invoke the Sketch mode, choose New from the File menu or choose the Create a new
object button from the File toolbar. The New dialog box is displayed with available
Pro/ENGINEER modes. Select the Sketch radio button to start a new file in the Sketch mode,
see Figure 1-1. When you select the Sketch radio button, a default name of the sketch
file appears in the Name edit box. You can change the sketch name as required and then
choose the OK button to enter the Sketch mode.

Figure 1-1 The New dialog box

THE SKETCHER ENVIRONMENT
When you invoke the Sketch mode, the initial screen appearance is similar to the one shown
in Figure 1-2. This figure also shows the Sketcher Tools toolbar that is displayed on the right
side of the graphics window. The buttons available in this toolbar are used to draw sketches.
The drawing tools are also available in the Sketch menu in the menu bar. When you enter the
sketcher environment, the Intent Manager is on by default. Also, when you are in the selection
mode, shortcut menus can be invoked by holding down the right mouse button in the
graphics window. The options in these shortcut menus vary depending on the item selected.
These shortcut menus also contain the tools to draw sketches.
Note
The selection mode in the sketcher environment is discussed later in this chapter.
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Figure 1-2 Initial screen appearance in the Sketch mode
The Navigator is displayed on the left side of the graphics window. It covers a part of the
graphics window and therefore the drawing area is decreased. You can make the Navigator
slide in by clicking the Navigator sash. Now, the area available for sketching is increased.
Note
The functions of Navigator are discussed in the Introduction chapter.

WORKING WITH THE SKETCH IN THE SKETCH MODE
When you invoke the sketcher environment, the Select items button is chosen by default. If
this button is chosen, the sketcher environment is said to be in the selection mode. In the
selection mode, you can select entities of the sketch to edit or to invoke the shortcut menu.
The options in the shortcut menu can be used to apply various operations on the selected
item.
Note
The sketch is saved with a .sec file extension. While drawing a sketch in the part file, if you save
the sketch in the sketcher environment, this sketch is also saved with the .sec file extension.
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DRAWING A SKETCH USING THE SKETCHER TOOLS
TOOLBAR
When you are in the sketcher environment, the Sketcher Tools toolbar that is available on
the Right Toolchest, which contains the tools to draw a sketch, dimension it, and modify
the dimensions. In this section, you will learn how to draw sketched entities using the tools
available in the Sketcher Tools toolbar.

Placing a Point
Points are generally used for dimensioning the vertices that are removed while
applying fillets. For example, if the sketch is to be dimensioned using these vertices,
you need to place points on them before applying fillets. Now, since a point is placed
at the vertex, you can easily use it for dimensioning the sketch. The following steps explain
the procedure to sketch a point:
1. Choose the Create points button from the Sketcher Tools toolbar; the system prompts
you to select a location for the point.
2. As soon as you select the location of the point by clicking, the point is placed at the
desired location in the graphics window.
Note
To increase the number of visible command prompt lines in the Message Area, select the top
sash of the Message Area using the left mouse button and drag it upwards, toward the screen.
When you draw a single point no dimensions appear. But, when you draw two points, they are
dimensioned with each other.

Drawing a Line
To draw lines, there are three tool buttons available in the Sketcher Tools toolbar. To view
these buttons, choose the black arrow on the right of the Create 2 point lines button; the
flyout appears with three tool buttons. The first button is Create 2 point lines. This button is
used to create a line by selecting two points in the graphics window. The second button on
the flyout is Create lines tangent to 2 entities. This button is used to create a tangent
between two entities. The third button is Create 2 point centerlines. This button is used to
create a centerline by selecting two points in the graphics window. The centerline is used
for creating revolved features, mirroring, and so on.
The procedure to create lines using these tools are discussed next.

Evaluation chapter. Logon to www.cadcim.com for more details

Note
You can create a simple sketch by using the options available in the shortcut menu. To invoke the
shortcut menu, hold down the right mouse button in the graphics window. Note that, once the
shortcut menu is displayed, the right mouse button can be released.
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Drawing a Line Using the Create 2 point lines Tool
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The following steps explain the procedure to create a line using the Create 2 point
lines tool:
1. Choose the Create 2 point lines button. Click on graphics window to start the line; a
rubber-band line appears from the selected point with the other end attached to the
cursor. The symbols V and H that appear while drawing the vertical and horizontal lines
are called constraints. Constraints are discussed in detail later in this chapter.
2. The system prompts you to specify the endpoint. Move the cursor in the graphics
window to a desired location and click to specify the endpoint of the line; the line
appears in yellow color. The rubber-band line continues and you can draw the second
line.
3. Repeat step 2 until all lines are drawn. You can end the line creation by pressing the
middle mouse button. To abort line creation, use the middle mouse button.
Note
When you draw a single line, the color of the line after you have drawn it is red. If you draw
multiple lines, the color is yellow.
After drawing a line, when you press the middle mouse button to end the line creation, the line
drawn is highlighted in red color. In the sketcher environment, the red color of an entity indicates
that it is selected. If you press the DELETE key, the line will be erased from the graphics
window. After drawing a line, weak dimensions in gray color are applied to the sketch. The
weak dimensions are applied automatically to the sketched entities as you draw them.

Drawing a Line Using the Create lines tangent to 2 entities Tool
The Create lines tangent to 2 entities button is used to draw a tangent between two
entities such as arcs, circles, splines, or a combination of these. The following steps
explain the procedure to draw a tangent using this tool:
1. Choose the arrow on the right of the Create 2 point lines button and then choose the
Create lines tangent to 2 entities button from the Sketcher Tools toolbar. You are
prompted to select start location on arc or circle.
2. Select the first entity from where the tangent line will be drawn; the color of the selected
entity changes to red. Now, you are prompted to select the end location on arc or circle.
As soon as you select the second entity, a line that is tangent to both the selected entities
is drawn.
Note
Whenever you are prompted to select an entity in the sketcher environment, the SELECT dialog
box is displayed. You can ignore this dialog box because it appears automatically and disappears
without any confirmation.
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You can draw horizontal, vertical, or inclined centerlines using the Create 2
point centerlines button. This button is available in the flyout that is displayed
when you choose the black arrow on the right of the Create 2 point lines button.
The centerline in a sketch is used as an axis of rotation, for mirroring , aligning, and
dimensioning entities.
The following steps explain the procedure to draw a centerline:
1. In the Sketcher Tools toolbar, choose the black arrow on the right of the Create 2 point
lines button and then choose the Create 2 point centerlines button; you are prompted
to select the start point.
2. Click in the graphics window to specify the start point. Now, you are prompted to select
the end point.
3. Click in the graphics window to specify the endpoint. A centerline of infinite length is
drawn.

Drawing a Rectangle
The following steps explain the procedure to sketch a rectangle using the Create
rectangle tool:
1. Choose the Create rectangle button from the Sketcher Tools toolbar; you are prompted
to select two points to indicate the diagonal of box. Click to specify the first point; a
yellow rubber-band box appears with the cursor attached to the opposite corner of the
box.
2. Move the cursor to the desired location in the graphics window to size the diagonal of
the rectangle. Click to specify the second point for the diagonal of the rectangle.

Drawing a Circle
In the Sketcher Tools toolbar, there are four tools to draw a circle and one tool to draw an
ellipse. To view the tools available to draw circles and ellipses, choose the black arrow on the
right of the Create circle by picking the center and a point on the circle button. The flyout
appears with five buttons. The procedures to create circle and ellipse using the various tools
are discussed next.

Drawing a Circle Using the Create circle by picking the center and a
point on the circle Tool
As the name suggests, the Create circle by picking the center and a point on the
circle tool is used to draw a circle by specifying the center of the circle and a point on
it. The following steps explain the procedure to draw a circle using this tool.
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1. Choose the Create circle by picking the center and a point on the circle button; you are
prompted to select the center of a circle.
2. Click in the graphics window to specify the center point of the circle; you are prompted
to select a point on the circle. A yellow rubber-band circle appears with the center at the
specified point and the cursor attached to its circumference.
3. Move the cursor to size the circle. Click to complete the circle creation; you are again
prompted to select the center of the circle.
4. Repeat steps 2 and 3 until you have drawn all required circles. If you want to abort circle
creation, press the middle mouse button.

Drawing a Construction Circle
A construction circle is a circle that is used to align entities, create diametrical or radial
dimensioning, and to reference entities. Figure 1-3 shows an application of construction
circle. In the sketch of a flange, centers of the circles lie on a particular bolt circle diameter
(BCD) that is defined using a construction circle.

Figure 1-3 Sketch of a flange
To create a construction circle, draw a circle or select a previously
drawn circle. Then, hold down the right mouse button on it to
invoke the shortcut menu, as shown in Figure 1-4. Choose the
Construction option from the shortcut menu. The circle appears
yellow in color and with a dashed line style, indicating that it is a
construction circle.

Drawing a Circle Using the Create concentric circle
Tool
The following steps explain the procedure to draw a
concentric circle using the Create concentric circle tool:

Figure 1-4 Construction
option in the shortcut menu
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1. Choose the Create concentric circle button from the flyout in the Sketcher Tools toolbar;
you are prompted to select an arc to determine the center. You can select an arc or a circle
to specify the center point.
2. Click on an arc or a circle to determine the concentricity of the circle to be drawn. Move
the mouse to size the circle.
3. After sizing the circle, finish circle creation by clicking and then pressing the middle
mouse button to end circle creation.

Drawing a Circle Using the Create circle by picking its 3 points Tool
The following steps explain the procedure to draw a circle using the Create circle by
picking its 3 points tool:
1. Choose the Create circle by picking its 3 points button from the flyout in the Sketcher
Tools toolbar; you are prompted to specify the first point on the circle.
2. Click for the first point at the desired location in the graphics window; you are prompted
to select the second point on the circle. Move the cursor and click to select the second
point in the graphics window.
3. As soon as you select the second point, a yellow rubber-band circle appears with the
cursor attached to it. You are prompted to select the third point. Move the mouse to size
the circle and click to specify the third point; a circle is drawn. You will be again prompted
to select first point on the circle to draw the next circle.
4. You can draw another circle or press the middle mouse button to end circle creation or to
abort circle creation before the next circle is completed.

Drawing a Circle Using the Create a circle tangent to 3 entities Tool
The Create a circle tangent to 3 entities tool is used to draw a circle that is tangent
to three existing entities. This tool references other entities to draw a circle. The
circle created using this tool is drawn irrespective of the points selected on the entities.
The following steps explain the procedure to draw a circle using the Create a circle tangent
to 3 entities tool:
1. Choose the Create a circle tangent to 3 entities button from the flyout in the Sketcher
Tools toolbar; you are prompted to select the start location on an arc, circle, or line.
2. Click to select the first entity. The color of the entity changes to red and you are prompted
to select an end location on an arc, circle, or line. Select the second tangent entity. Next,
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Tip: To convert a construction circle back to a solid entity, select the construction
circle and hold down the right mouse button to invoke the shortcut menu. Choose the
Solid option from this shortcut menu.
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you are prompted to select the third location on an arc, circle, or line. Select the third
tangent entity.
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As you select the three entities, a circle that is tangent to these three entities is drawn.
3. To end the creation of circle, press the middle mouse button.

Drawing an Ellipse Using the Create a full ellipse Tool
The following steps explain the procedure to draw an ellipse using the Create a full
ellipse tool:
1. Choose the Create a full ellipse button from the flyout in the Sketcher Tools toolbar;
you are prompted to specify the center of an ellipse.
2. Click at the desired location in the graphics window to specify the center point; a yellow
rubber-band ellipse appears with the cursor attached to the ellipse. Move the cursor in
the graphics window to size the ellipse.
3. An ellipse is drawn when you click to specify the second point.

Drawing an Arc
To draw an arc there are five tools in the Sketcher Tools toolbar. To view them,
choose the black arrow on the right of the Create an arc by 3 points or tangent to an
entity at its endpoint button; the flyout appears with five buttons. The procedures to
draw arcs using various tool buttons in the flyout are discussed next.

Drawing an Arc Using the Create an arc by 3 points or tangent to an
entity at its endpoint Tool
The Create an arc by 3 points or tangent to an entity at its endpoint tool is used to draw arcs
tangent from the endpoint of an existing entity or by defining three points in the graphics
window.
When you choose this button to draw an arc from an endpoint, the Target symbol is displayed
as soon as you select the endpoint. This Target symbol is in the form of a circle that is divided
into four quadrants. The following steps explain the procedure to draw an arc from the
endpoint of an existing entity by using this tool:
1. Choose the Create an arc by 3 points or tangent to an entity at its endpoint button from
the Sketcher Tools toolbar; you are prompted to select the start point of the arc.
2. Specify three points in the graphics window to draw an arc. If you want to draw an arc
from the endpoint of an existing entity, select the endpoint of that entity. As soon as you
select the endpoint, the Target symbol appears at the endpoint of the entity. Move the
cursor along the tangent direction through a small distance, a yellow rubber-band arc
appears with one end attached to the endpoint of the entity and the other end attached
to the cursor. Note that when you move the cursor out of the Target symbol perpendicular
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to the endpoint, the arc is drawn by specifying three points. In this case the rubber-band
arc does not appear, as shown in Figure 1-5.

3. Move the cursor to the desired position in the graphics window to size the arc. Use the
left mouse button to complete the arc.
Tip: If you do not want to draw a tangent arc, move the cursor out of the Target
symbol perpendicular to the endpoint.

Figure 1-5 Cursor moved out of Target symbol
perpendicular to the endpoint

Figure 1-6 Cursor moved out of the Target symbol
along the tangent direction.

Drawing an Arc Using the Create concentric arc Tool
The Create concentric arc tool is used to draw an arc concentric to an existing arc.
You will have to select an entity to which the arc will be concentric. The entity selected
must be an arc or a circle. The following steps explain the procedure to draw an arc
using this tool:
1. Choose the Create concentric arc button from the flyout in the Sketcher Tools toolbar;
you are prompted to select an arc to determine the center of the arc to be created.
2. As soon as you select an entity, a dotted circle appears on the screen and you are prompted
to select the start point of the arc. After doing so, a yellow rubber-band arc will appear
with one end attached to the start point. The length of the arc will change as you move
the cursor. Next, you are prompted to select the endpoint of the arc.
3. Click to specify the endpoint; the arc is created.
4. You can continue drawing another arc or end arc creation by pressing the middle mouse button.
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On the other hand, if you move the cursor out horizontally from one of the quadrants of
the Target symbol, the arc is drawn tangent to the endpoint, as shown in Figure 1-6.
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Drawing an Arc Using the Create an arc by picking its center and
endpoints Tool
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The following steps explain the procedure to draw an arc using the Create an arc by
picking its center and endpoints tool:
1. Choose the Create an arc by picking its center and endpoints button from the flyout in
the Sketcher Tools toolbar; you are prompted to select the center of the arc.
2. Click to specify a center point for the arc in the graphics window; a yellow colored center
mark appears at that point. Now, you are prompted to select the start point of the arc. As
you move the cursor, a dotted circle appears and is attached to the cursor.
3. Select the start point of the arc on the circumference of the dotted circle; a yellow
rubber-band arc appears from the start point. The length of this arc changes dynamically
as you move the cursor.
4. You are prompted to select the endpoint of the arc. Move the cursor to size the arc, and
then click to select the endpoint of the arc. An arc is drawn between the two selected
points.
Note
You can draw only one arc with one center. If you want to draw another arc you will have to
select the center again.

Drawing an Arc Using the Create an arc tangent to 3 entities Tool
The Create an arc tangent to 3 entities tool is used to draw an arc that is tangent to
three selected entities. The following steps explain the procedure to draw an arc
using this tool:
1. Choose the Create an arc tangent to 3 entities button from the flyout in the Sketcher
Tools toolbar; you are prompted to select the start location on an arc, circle, or line.
2. As soon as you select the first entity, the color of the entity changes to red. Now, you are
prompted to select the end location on an arc, circle, or line.
3. After doing so, you are prompted to select a third location on an arc, circle, or line. Select
a third entity. An arc is drawn tangent to the three entities selected.
4. You can continue drawing arcs or press the middle mouse button to abort arc creation.

Drawing an Arc Using the Create a conic arc Tool
The Create a conic arc tool is used to draw a conic arc. The following steps explain
the procedure to draw a conic arc using this tool:
1. Choose the Create a conic arc button from the flyout in the Sketcher Tools toolbar; you
are prompted to specify the first endpoint of the conic entity.
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3. Specify the second endpoint; a centerline is drawn between the two points. Now, you are
prompted to specify the shoulder point of the conic. Specify a point on the screen; the
conic arc is drawn.
Note
If you delete the centerline of the conic arc, the arc will not be deleted.
Remember that if the conic arc is the only entity in the graphics window, then you cannot delete
its centerline.

DIMENSIONING THE SKETCH
After you draw a sketch, the next step involves the dimensioning of the sketch. The basic
purpose of dimensioning in Pro/ENGINEER is to control the size of the sketch and to locate
it with some reference. In Pro/ENGINEER, a sketch cannot be regenerated unless it is fully
dimensioned and constrained. The phrase “the sketch cannot be
regenerated” means that the sketch cannot be accepted by Pro/ENGINEER.
By default, the sketched entities are dimensioned and constrained
automatically while sketching or as soon as you are done with the sketch.
However, sometimes you need to add additional dimensions to the sketch.
The Create defining dimension button in the Sketcher Tools toolbar is Figure 1-7
used to manually dimension the entities. You can also choose Sketch > Dimensioning
Dimension from the menu bar to display a cascading menu, as shown in options
Figure 1-7. This menu contains different dimensioning options.
Note
When the intent manager is off, the dimensions and constraints are not automatically applied. You
need to manually add the dimensions by choosing the Dimension option form the SKECHER menu.

Dimensioning a Sketch Using the Create defining dimension
button or the Normal Option
The Create defining dimension button or the Normal option are used for normal
dimensioning of the sketch. The following steps explain the procedure to dimension a sketch:
1. Choose the Create defining dimension button from the Sketcher Tools toolbar. Click
on the entity you want to dimension; the color of the entity changes from yellow to red.
2. Move the cursor and place the dimension at the desired place by pressing the middle
mouse button. You can modify the dimension values using the modifying options discussed
later in this chapter.
The remaining options in the cascading menu are not used while sketching and therefore,
they are discussed in Chapter 2.
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2. Specify a point in the graphics window; you are prompted to specify the second endpoint
of the conic entity.
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DIMENSIONING THE BASIC SKETCHED ENTITIES
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Choose the Create defining dimension button and follow the procedures given below to
dimension the sketched entities.

Linear Dimensioning a Line
You can dimension a line by selecting its endpoints or by selecting the line. After selecting
the two endpoints or the line, press the middle mouse button to place the dimension. If the
line is inclined and you select the two endpoints to dimension, then the location where you
press the middle mouse button is important, because it defines the orientation of the dimension
that is displayed on the screen.
Figure 1-8 explains the three possible orientations of dimension that can be displayed when
you dimension a line.

Figure 1-8 Approximate locations of the cursor to achieve different dimensions
Note
It is not possible to dimension a line in the three orientations at the same time in the sketcher
environment. The dimensions in Figure 1-8 are only for explanation.

Angular Dimensioning of an Arc
To add angular dimension to an arc, select both ends of the arc by pressing the left mouse
button and then select a point on the arc. Next, place the dimension at the desired point by
pressing the middle mouse button. The dimension appears, as shown in Figure 1-9. You can
modify the dimension using tools that are discussed later.

Diameter Dimensioning
For diameter dimensioning, click on a circle twice. Then place the dimension at the desired
location by pressing the middle mouse button. The diameter dimension is displayed, as
shown in Figure 1-10. The same diameter dimensioning technique can also be used for arcs.

1-15

Figure 1-9 Angular dimensioning

Figure 1-10 Diameter dimensioning

Radial Dimensioning
For radial dimensioning, click on the entity once. Then place the dimension at the desired
location by pressing the middle mouse button. The radial dimension is displayed, as shown
in Figure 1-11.

Dimensioning Revolved Sections
Revolved sections are used to create revolved features such as flanges, couplings, and so on.
To dimension a revolved section, click on the entity to be dimensioned. Next, select the
centerline about which you want the section to be revolved. Once again select the original
entity that you want to dimension. Now, place the dimension at the desired location by pressing
the middle mouse button. The dimension is displayed, as shown in Figure 1-12. This
dimension represents the diameter of a revolved section.

Figure 1-11 Radial dimensioning

Figure 1-12 Dimensioning for revolved sections

Tip: To add dimension to a revolved section, you can also first select the centerline,
next the entity to dimension, and then again the centerline.
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WORKING WITH CONSTRAINTS
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In Pro/ENGINEER, the entities in a sketch have to be fully specified in terms of size, shape,
orientation, and location. This is achieved by setting constraints. Using constraints in the
sketch reduces the number of dimensions in that sketch.
Constraints are the logical operations that are performed on the selected geometry to make
it more accurate in defining its position with respect to the other geometry. For example, if a
line is nearly parallel to another line, Pro/ENGINEER snaps the parallel line and displays
the parallel constraint symbol. Now, if you confirm the line creation, the line is drawn parallel
to the other line. You can also apply constraints manually.
There are two types of constraints in Pro/ENGINEER, Geometry constraints and Assembly
constraints. Here, you will learn about the Geometry constraints and the Assembly
constraints will be discussed in later chapters.
To apply constraints manually, choose the Impose sketcher
constraints on the section button from the Sketcher Tools
toolbar to display the Constraints dialog box. This dialog
box is shown in Figure 1-13.
This dialog box is used to apply constraints manually. Although
the constraints are applied automatically as you draw the sketch, you
can use this dialog box if you want to manually apply additional
constraints. The constraints that are applied automatically are weak
constraints and they appear in gray color. Weak constraints can be
made strong and this is discussed later in this chapter. The constraints
in the Constraints dialog box are discussed next.

Make a line or two vertices vertical

Figure 1-13 The
Constraints dialog box

This constraint forces the selected line segment to become a vertical line. This
constraint also forces the two vertices to be placed along a vertical line.

Make a line or two vertices horizontal
This constraint forces the selected line segment or two vertices that are apart by
some distance to become horizontal or to lie in a horizontal line.

Make two entities perpendicular
This constraint forces the selected entity to become normal to another selected entity.

Make two entities tangent
This constraint forces the two selected entities to become tangent to each other.

Place point on the middle of the line
This constraint forces a selected point or vertex to lie on the middle of a line.
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Create same points, points on entity or collinear constraint

Make two points or vertices symmetric about a centerline
This constraint makes a section symmetrical about the centerline. When you select
this constraint, you are prompted to select a centerline and two vertices to make
them symmetrical.

Create Equal Lengths, Equal Radii, or Same Curvature
constraint
This constraint forces any two selected entities to become equal in dimension. When
you select this constraint, you are prompted to select two lines to make their lengths
equal, or you are prompted to select two arcs, circles, or ellipses to make their radii
equal.

Make two lines parallel
This constraint is used to force two lines to become parallel. When selected, this
constraint prompts you to select two entities that you want to make parallel.

Explain Option
The Explain option of the Constraints dialog box provides information about the constraints
that are applied to a sketch. The constraints in the sketch are displayed as symbols. When you
choose the Explain button, you are prompted to select the constraint or dimension on which
you want the explanation. Select the symbol using the left mouse button. The information about
the selected constraint is displayed in the Message Area.
Note
This option is generally helpful when you view a sketch drawn by some other person. By using
the Explain option you can obtain information about the various constraints applied in the
sketch.

Disabling the Constraints
The need to disable a constraint arises when you are drawing an entity. For example, if you
draw a circle at some distance apart from a circle. While drawing it, the system tends to apply
the equal radius constraint when the sizes of the two circles become equal. If at this moment
you do not want to apply the equal radius constraint, right-click to disable the equal radius
constraint. When you right-click to disable a constraint, an orange line / appears across the
symbol. To enable the constraint, right-click once again.

Converting a Weak Constraint into a Strong Constraint
As discussed earlier, when you draw a sketch, some weak dimensions are automatically applied
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This constraint performs three functions. This constraint can be used to force the
two selected points to become coincident to constrain a point on the selected entity,
and to make two selected entities collinear, so that they lie on the same line. This
constraint aligns two vertices or entities.

1-18

Pro/ENGINEER Wildfire for Designers (Evaluation Chapter WF206/04)

Evaluation chapter. Logon to www.cadcim.com for more details

to the sketch. As you proceed to complete the sketch, these
dimensions are automatically deleted from the sketch without any
confirmation.
Select a weak dimension or a weak constraint from the graphics
window. The selected dimension or constraint is highlighted in
red. Press and hold the right mouse button to invoke the shortcut
menu, as shown in Figure 1-14. Choose the Strong option from
the shortcut menu.
You can also choose Edit > Convert To > Strong from the menu
bar. The color of the selected dimension is changed from gray to
yellow, indicating that the selected constraint or dimension is
made permanent.

Figure 1-14 Shortcut
menu to convert the weak
dimensions to strong

MODIFYING THE DIMENSIONS OF A SKETCH
There are four ways to modify the dimensions of a sketch. These methods are discussed next.

Using the Modify the values of dimensions, geometry of
splines, or text entities Tool
You can select one or more dimensions from the sketch to modify. When you select
dimension(s) from a sketch, they are highlighted in red. If you want to select more
than one dimension, hold down the CTRL key and select the dimensions by clicking
on them. You can also use CTRL+ALT+A or define a window to select the dimensions in the
sketch. Choose the Modify the values of dimensions, geometry of splines, or text entities
button from the Sketcher Tools toolbar to modify the dimensions; the Modify
Dimensions dialog box is displayed, as shown in Figure 1-15.

Figure 1-15 The Modify Dimensions dialog box
To modify dimensions using this dialog box, you can either enter a value in the edit box or
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By default, the Regenerate check box is selected and any modifications in the dimensions
are automatically updated in the sketch. If you want to delay the modification process of the
sketch based on the new value of the selected dimension, you need to clear this check box. If
this check box is cleared, the dimensions will not be modified until you exit this dialog box.
This means that Pro/ENGINEER allows you to make multiple modifications before updating
the sketch.
Note
It is recommended that you clear the Regenerate check box and then modify the dimensions if
you have to modify more than one dimension.
The Lock Scale check box is used to lock the scale of the selected dimensions. After locking
the scale, if you modify any dimension, all other dimensions will also be modified by the
same scale.

Using the Edit Menu
The Modify option available in the Edit menu in the menu bar can also be used to modify
the dimensions. When you choose the Modify option from the Edit menu, a check mark
appears to the left of the Modify option in the Edit menu. Now, you can select a dimension
from the sketch to modify. When you select a dimension, the Modify Dimensions dialog box
is displayed. By default, the Regenerate check box is selected. Therefore, the sketch will be
regenerated dynamically as you modify the dimension.

Modifying a Dimension by Double-Clicking
You can also modify a dimension by double-clicking on it. When you double-click on a
dimension, the pop-up text field appears. Enter a new dimension value in this field and
press ENTER or use the middle mouse button. Remember that you can select a dimension
only when you choose Select items button from the Sketch Tools toolbar.

Modifying Dimensions Dynamically
In the sketcher environment, Pro/ENGINEER is always in the selection mode, unless you
have invoked some other tool. When you bring the cursor to an entity, the color of the entity
changes to cyan. Now, if you hold down the left mouse button, you can modify the entity by
dragging the mouse. You will notice that as the entity is modified, the dimensions referenced
to the selected entity are also modified.

RESOLVE SKETCH DIALOG BOX
While applying constraints or dimensions, the system may sometimes prompt you to delete
one or more highlighted dimensions or constraints. This is because while adding dimensions
or constraints some strong dimensions or constraints conflict with the existing dimensions
or constraints. As soon as the conflict occur, the Resolve Sketch dialog box is displayed, as
shown in Figure 1-16 and the constraints or dimensions under conflict are displayed in red.

Evaluation chapter. Logon to www.cadcim.com for more details

use the thumbwheel that is available on the right of the edit box. The Sensitivity slider is
used to set the sensitivity of the thumbwheel.
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When you select a dimension or constraint from
the Resolve Sketch dialog box, the corresponding
dimension or constraint in the graphics window
is enclosed in a yellow box. The buttons available
in the Resolve Sketch dialog box are discussed next.

Undo
When you choose the Undo button, the section is
brought back to the state that was just before the
conflict occurred.

Delete
The Delete button is used to delete a selected
dimension or constraint that is enclosed within the Figure 1-16 The Resolve Sketch dialog box
yellow box. Select the dimension or the constraint
to delete before you choose the Delete button from the Resolve Sketch dialog box.

Dim > Ref
When you choose the Dim > Ref button, the selected dimension is converted to a reference
dimension.
Note
The reference dimensions are used only for reference. They do not participate in feature creation.

Explain
When you choose the Explain button, the system provides you with information about the
selected constraint or dimension. The information is displayed in the Message Area.

DELETING THE SKETCHER ENTITIES
To delete a sketched entity, select it by defining a window. You can specify a window by
picking two points so that the entity or entities are enclosed in the window. After specifying
the window, the color of the selected entity changes to red. Right-click in the graphics
window and hold down the right mouse button until a shortcut menu appears. Now, choose
the Delete option from this menu to delete the selected item.
You can also delete an item by selecting it and pressing the DELETE key when the selected
item turns red in color.
To delete more than one item from the graphics window, press the CTRL key and click to
select the entities to be deleted. Press the DELETE key to delete the selected entities. You can
also specify a window to select the entities.
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The Geometry, Dimension, and Constraint filters are available in the drop-down list located
in the status bar. These filters allow you to select exactly the item that you need to select. This
means, if you want to select all constraints in the sketch, choose the Constraint filter and specify
a window to select. You will notice that only the constraints are selected.
To restore the last deleted item, choose the Undo button. This button is available in
the Edit toolbar on the Top Toolchest.

TRIMMING THE SKETCHER ENTITIES
When creating a design, there are a number of places where you need to remove the unwanted
and extended entities. You can do this by using the tools available for trimming that are
available in the Sketcher Tools toolbar. You can trim entities using three tools. These tools
are discussed next.

Dynamically trim section entities Tool
This tool button deletes the selected entities. After choosing the Dynamically trim
section entities button, when you move the cursor over an entity, the entity is
highlighted in cyan color. Press the left mouse button to trim the entity. This tool
button also trims entities that extend beyond the point of intersection.

Trim entities (cut or extend) to other entities or geometry
Tool
The Trim entities (cut or extend) to other entities or geometry button is used to
trim two entities at their corners. Note that when you trim entities using this option,
the portion from where you select the entities is retained and the other portion is
trimmed. The following steps explain the procedure to trim entities using this tool button:
1. Choose the black arrow on the right of
the Dynamically trim section entities
button to display the flyout. From this
flyout, choose the Trim entities (cut or
extend) to other entities or geometry
button; you are prompted to select two
entities to be trimmed.
2. Click to select the two entities on the
sides you want to keep after trimming,
see Figure 1-17. These two entities must
be intersecting entities. The entities are
trimmed from the point of intersection.

Figure 1-17 Trimming the lines
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Note
It is necessary to be in the selection mode while selecting the items. The term “items” used in this
chapter refers to dimensions and entities.
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Divide an entity at the point of selection Tool
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The Divide an entity at the point of selection button is used to divide an entity into
any number of parts or entities by specifying points on the entity.
This button is available on the flyout that is displayed when you choose the black arrow that
is on the right side of the Dynamically trim section entities button.
The following steps explain the procedure to divide an entity:
1. Choose Divide an entity at the point of selection button from the flyout; you are prompted
to select an entity to be divided.
2. Click to select the entity at the point where you want to divide it. The entity is divided
into two different entities. They can now be treated as two separate entities.
3. Similarly, you can break other entities like circles or arcs into several smaller entities.

MIRRORING THE SKETCHER ENTITIES
The Mirror selected entities button is used to mirror sketched geometries about a
centerline. This tool helps to reduce the time used for creation of symmetrical
geometries and dimensioning them.
The following steps explain the procedure to mirror a sketched geometry:
1. Sketch a geometry and then sketch a centerline about which you need to mirror the geometry.
2. Select the entities that you need to mirror. The selected entities turn red in color.
3. Choose the Mirror selected entities button from the Sketcher Tools toolbar. You are
prompted to select the centerline about which you need to mirror, hence do so. The
selected entities are mirrored about the centerline.
Tip: In case of symmetrical parts, you can save time involved in dimensioning a
sketch by dimensioning half of the section and then mirroring it. Pro/ENGINEER
will assume that the mirrored half has the same dimensions as the sketched half.

DRAWING DISPLAY OPTIONS
While working with complex sketches, sometimes you need to increase the display of a
particular portion of a sketch so that you can work on the minute details of the sketch. For
example, you are drawing a sketch of a piston and you have to work on the minute details of
the grooves for the piston rings. To work on these minute details, you have to enlarge the
display of these grooves. You can enlarge or reduce the drawing display using various
drawing display tools provided in Pro/ENGINEER. These tools are available in the View
toolbar. Some of these drawing display options are discussed next. The remaining drawing
display options will be discussed in later chapters.
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This tool enlarges the view of the drawing on the screen. After choosing the Zoom In
button, you will be prompted to define a box. The area that you will enclose inside
the box will be enlarged and displayed in the graphics window. Note that when you
enlarge the view of the drawing, the original size of the entities is not changed. To exit the
zoom tool right-click in the graphics window.

Zoom Out
This tool reduces the view of the drawing on the screen, thus increasing the drawing
display area. Each time you choose this button to zoom out, the display of the sketch
in the graphics window is reduced.

Refit object to fully display it on the screen
This option reduces or enlarges the display such that all entities that comprise the
sketch are fitted inside the current display. Note that the dimensions may not
necessarily be included in the current display.

Redraw the current view
While working with complex sketches, some unwanted temporary information is
retained on the screen. The unwanted information may include the shadows of the
deleted sketched entities, dimensions, and so on. This unwanted information can be
removed from the graphics window using the Redraw the current view button. This option
is extensively used when designing in Pro/ENGINEER.
Note
To remove the temporary information you can also choose View > Repaint from the menu bar
or CTRL+R to repaint the screen.
If you have a mouse that has a middle mouse button wheel, then scrolling the wheel will zoom
in and out.
One more way to zoom in and out is to use the middle mouse button and the CTRL key. When
you use CTRL+middle mouse button and drag the mouse upward the sketch is zoomed out and
when you drag the mouse downward, the sketch is zoomed in.
In the Sketch mode, you can pan the sketch using the middle mouse button but in the Part
mode, use SHIFT+middle mouse button to pan the model.

TUTORIALS
Tutorial 1
In this tutorial, you will draw the sketch for the model shown in Figure 1-18. The sketch is
shown in Figure 1-19.
(Expected time: 30 min)
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Zoom In
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Figure 1-18 Model for Tutorial 1

Figure 1-19 Sketch of the model

The following steps are required to complete this tutorial:
a.
b.
c.
d.
e.
f.

Start Pro/ENGINEER Wildfire 2.0 session.
Set the working directory and create a new sketch file.
Draw lines using the line tool, refer to Figures 1-20 and 1-21.
Draw an arc and a circle, refer to Figures 1-22 and 1-23.
Dimension the sketch and then modify the dimensions of the sketch, refer to Figure 1-24
Save the sketch and close the file.

Starting Pro/ENGINEER
1. Start Pro/ENGINEER Wildfire 2.0 by double-clicking on the Pro/ENGINEER icon on
the desktop of your computer or by using the Start menu.

Setting the Working Directory
When the Pro/ENGINEER session is started, the first task is to set the working directory.
A working directory is a directory on your system where you can save the work done in
the current session of Pro/ENGINEER. You can set any directory existing on your system
as the working directory. Because this is the first tutorial of this chapter, you need to
create a folder named c01, if it does not exist.
1. Choose the Set Working Directory option from the File menu. The Select Working
Directory dialog box is displayed.
2. Browse and select C:\ProE-WF-2.0. If this folder is non existing then create it prior to
setting the working directory.
3. Choose the New Directory button in the Select Working Directory dialog box;
the New Directory dialog box is displayed.
4. Type c01 in the New Directory edit box and choose OK from the dialog box. You have
created a folder named c01 in C:\ProE-WF-2.0.
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5. Choose OK from the Select Working Directory dialog box. You have set the working
directory to C:\ProE-WF-2.0\c01. A message is displayed in the Message Area that the
directory successfully changed to C:\ProE-WF-2.0\c01 directory.

Any sketch drawn in the Sketch mode is saved with the .sec file extension. This file format
is one of the file formats available in Pro/ENGINEER.
1. Choose the Create a new object button from the File toolbar. The New dialog
box is displayed. Select the Sketch radio button from the Type area of the New
dialog box. A default name of the sketch appears in the Name edit box.
2. Enter c01tut1 in the Name edit box and choose the OK button.
You are in the sketcher environment of the Sketch mode. When you enter the sketcher
environment, the Navigator is displayed to the left in the graphics window.
3. Slide in the Navigator to the left by clicking on the sash present on its right edge. Now,
the drawing area is increased.

Drawing the Lines of the Sketch
Start drawing the sketch with the right vertical line.
1. Choose the Create 2 point lines button from the Sketcher Tools toolbar.
2. Specify the start point to the right in graphics window by clicking. One end of the line
is attached to the cursor. Move the cursor down to get an approximate size of the line.
Notice that when the cursor is moved vertically downward, a red colored constraint V
appears in the graphics window next to the line. This indicates that if you draw a line
now, the vertical constraint will be applied to the line.
3. Click to specify the endpoint of the line. The vertical constraint V is applied to the line
and the symbol V appears in yellow. The color of the constraint indicates that this constraint
is strong. This means that you cannot change the orientation of this line until you delete
the constraint that is applied on the line.
Another rubber-band line is attached to the cursor with its start point at the endpoint of
the last line.
4. Move the cursor horizontally toward the left; a horizontal rubber-band line extends to
the left as you move the mouse.
5. After you get the desired size of the line, click to end the line. Notice that a horizontal
constraint H that is yellow in color is applied to the line.
6. Move the cursor upward in the graphics window; a vertical rubber-band line extends as
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you move the mouse. As you move the cursor upward, notice that at a particular point
where the length of the left vertical line is equal to the length of the right vertical line, L1
symbol is displayed on both the vertical lines. This symbol suggests that the equal length
constraint is applied to the two vertical lines.
7. When the L1 constraint appears on the vertical line, click to specify the endpoint of the
vertical line. Notice that the L1 constraint is displayed in gray color, as shown in Figure 1-20.
This suggests that it is a weak constraint. The rubber-band line is still attached to the
cursor.
You can also apply the constraints later. But to save an extra step of adding the constraints,
you will use the constraints that are applied automatically while drawing.
8. Move the cursor to size the line and specify the endpoint of the left inclined line, see
Figure 1-20.
9. Press the middle mouse button to end line creation. You will notice that gray colored
dimensions are applied to the sketch, see Figure 1-20. The color of these dimensions
indicates that these dimensions are weak dimensions. These dimensions are automatically
deleted when you have completed the sketch or when you are adding dimensions and
constraints manually. When system deletes weak dimensions, it does not confirm their
deletion.
10. The line option is still active. Move the cursor close to the top end of the right vertical
line. You will notice that as you bring the cursor close to the top end, the cursor snaps to
that point. Select the point by clicking.
11. Size the inclined line and specify the endpoint of the right inclined line. Press the middle
mouse button to end line creation.
Figure 1-21 shows the lines that you have drawn. Now, the arc and circle will be drawn.

Figure 1-20 Lines with weak dimensions

Figure 1-21 Partial sketch with weak dimensions
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Drawing the Arc

2. Select the endpoint of the left inclined line; the Target symbol appears in green color.
3. Move the cursor along the tangent direction through a small distance. A rubber-band arc
that is tangent to the endpoint of the line appears. As you move the cursor to the endpoint
of the right inclined line, at a particular point the tangent constraint is applied at both
the ends of the arc. This is indicated by the symbol T that appears on the endpoints of
the inclined lines.
4. As the tangent constraint appears, click to end arc creation. You will notice that the
tangent constraint with a symbol T appears at the endpoints of the arc, as shown in
Figure 1-22. Press the middle mouse button to end arc creation.
The tangent constraint T will appear in white, which suggests that it is a strong constraint
and the tangency of the inclined line with the arc cannot be modified until you delete the
tangent constraint.
Note that in Figure 1-21 there are some weak dimensions that are not displayed in
Figure 1-22. This is because the weak dimensions are deleted without confirming their
deletion. Hence, after drawing the arc some weak dimensions get deleted automatically.
Note
If the tangent constraint symbol is not displayed on any of the inclined lines, apply the constraint
manually using the Constraints dialog box that is displayed when you choose the Impose
sketcher constraints on the section button from the Sketcher Tools toolbar (see page 1-16
for more information).

Drawing the Circle
1. Choose the black arrow on the right of the Create circle by picking the center
and a point on the circle button to display the flyout. From this flyout, choose
the Create concentric circle button; you are prompted to select an arc.
2. Select the arc by clicking by clicking on it. Move the mouse and a circle appears.
3. To draw the circle, click to select a point inside the sketch.
4. Press the middle mouse button to end circle creation. The sketch is complete and appears
similar to that shown in Figure 1-23.

Dimensioning the Sketch
The right vertical line, the bottom horizontal line, the arc, and the circle are
dimensioned automatically and weak dimensions are applied to them. You will use
these dimensions. Hence, there is no need to dimension these entities again.
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1. Choose the Create an arc by 3 points or tangent to an entity at its endpoint
button from the Sketcher Tools toolbar. You are prompted to select the start
point of the arc.
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Figure 1-22 Sketch with arc

Figure 1-23 Sketch with all entities, weak
dimensions, and weak constraints

1. Choose the Create defining dimension button from the Sketcher Tools toolbar.
2. Select the center of the circle and then select the bottom horizontal line by clicking on
them. Both, the center and the line turn red in color.
3. Place the dimension on the right of the sketch by pressing the middle mouse button.
4. Select the center of the circle and then select the left vertical line. Both the center and
the vertical line turn red in color.
5. Press the middle mouse button to place the dimension below the sketch, refer to
Figure 1-24.

Modifying the Dimensions
The sketch is dimensioned with default values. You need to modify these values to the
given values.
1. Choose the Select items button.
2. Select all dimensions by specifying a window around them.
Note
You can also use CTRL+ALT+A to select the entire sketch with dimensions.
3. When all dimensions turn red in color, choose the Modify the values
of dimensions, geometry of splines, or text entities button. The Modify
Dimensions dialog box is displayed.
All dimensions in the sketch are displayed in this dialog box and each dimension has a
separate thumbwheel and an edit box. You can use the thumbwheel or the edit box to
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modify the dimensions. It is recommended that you use the edit boxes to modify the
dimensions if the change in the dimension value is large.

When you clear this check box, any modification in a dimension value does not update
the sketch. It is recommended that you clear the Regenerate check box when more than
one dimension has to be modified.
Notice that the dimension you select in the Modify Dimensions dialog box gets enclosed
in a yellow box in the graphics window.
5. Modify all dimensions, as shown in Figure 1-24. After modifying the dimensions, choose
the Regenerate the section and close the dialog button from the Modify Dimensions
dialog box. A message Dimension modifications successfully completed is displayed in
the Message Area.
The sketch is complete and is shown in Figure 1-24.

Figure 1-24 The complete sketch with dimensions and constraints
Tip: You can modify the location of the dimensions as they appear on the screen by
selecting and dragging them to a new location.

Saving the Sketch
The sketch will now be saved. You have to save the sketch because you may need the
sketch later in the Part mode in order to create a 3D model.
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4. Clear the Regenerate check box and then modify the values of the dimensions.
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1. Choose Save the active object button from the File toolbar. The Save Object
dialog box is displayed with the name of the sketch that you had entered earlier.
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2. Choose the OK button; the sketch is saved.
3. After saving the sketch, choose Window > Close from the menu bar.

Tutorial 2
In this tutorial, you will draw the sketch for the model shown in Figure 1-25. The sketch is
shown in Figure 1-26. For your reference, all entities in the sketch are labeled alphabetically.
(Expected time: 30 min)

Figure 1-25 Model for Tutorial 2

Figure 1-26 Sketch of the model

The following steps are required to complete this tutorial:
a. Set the Working directory and create a new object file.
b. Draw the sketch using the line tool, refer to Figure 1-27.
c. Dimension the required entities and then modify the dimensions of the sketch, refer to
Figures 1-28 and 1-29.
d. Save the sketch and close the file.

Setting the Working Directory
The working directory was selected in Tutorial 1, and therefore there is no need to select
the working directory again. But if a new session of Pro/Engineer is started, then you
have to again set the working directory by following the steps given next.
1. Open the Navigator by clicking the top arrows on the left edge of the Pro/ENGINEER
main window; the Navigator slides out.
2. Click on the plus symbol adjacent to the ProE-WF-2.0 folder in the Navigator; the
contents of the ProE-WF-2.0 folder are displayed.
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3. Now right-click on the c01 folder to display a shortcut menu. From this shortcut menu,
choose the Set Working Directory option; the working directory is set to c01.

Starting a New Object File
1. Choose the Create a new object button from the File toolbar; the New dialog
box is displayed. Select the Sketch radio button from the Type area of the New
dialog box; a default name of the sketch appears in the Name edit box.
2. Enter c01tut2 in the Name edit box and choose OK, you are in the sketcher environment
of the Sketch mode.

Drawing the Sketch
The sketch in Figure 1-26 consists of only lines. For ease of understanding, all lines in the
sketch are labelled alphabetically.
1. Choose the Create 2 point lines button from the Sketcher Tools toolbar. Select a
point close to the lower right corner of the graphics window by clicking and
start drawing the horizontal line A. Here, you will notice that as you draw line A, the
H symbol is displayed on the line. This indicates that the line is horizontally constrained.
Move the cursor toward the left and specify the endpoint of the line.
2. Move the cursor vertically upwards so that the V constraint appears on the line. When
you get the appropriate size of the line, click to specify the endpoint of line B; line B is
completed.
3.

Move the cursor to the right in the graphics window and click to specify the endpoint of line C.

4. Now, to draw line D, move the cursor down and click to specify the endpoint of line D.
5. Line E is inclined. Move the cursor to size the line and click to specify the endpoint of
line E.
6. The next line you need to draw is line F. Move the cursor vertically downwards and click
to specify the endpoint of line F.
7. Now, to draw line G, move the cursor horizontally toward the left and click to specify the
endpoint of line G.
8. Move the cursor vertically upwards and click to specify the endpoint of line H.
9. Now, continue drawing the remaining lines that are shown in Figure 1-27. When the
sketch is complete, end line creation by pressing the middle mouse button. Notice that
the sketched entities are dimensioned automatically as you draw them. These dimensions
are weak dimensions and appear in gray color.
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4. Close the Navigator by clicking on the sash located at the right edge of Navigator. The
Navigator slides in.
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Applying the Constraints to the Sketch
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Constraints are applied to the sketch to maintain the design intent of the feature and this
might sometimes result in less dimensions in the sketch.
1. Choose the Impose sketcher constraints on the section button from the Sketcher
Tools toolbar; the Constraints dialog box is displayed.
2. Choose the Create Equal Lengths, Equal Radii, or Same Curvature constraint
button and select lines F and H. The equal length constraint L2 is applied to both
the lines. The constraint labels such as L2 or L3 vary from sketch to sketch.
3. Select lines C and K; the equal length constraint is applied to both the lines.
4. Now, select lines J and N; the equal length constraint is applied to both the lines.
5. Select lines A and B. The equal length constraint is applied to both the lines.
6. Choose the Make line or two vertices horizontal button from the Constraints
dialog box; you are prompted to select a line or two vertices.
7. Select the vertex that is joining lines L and M and the vertex that is joining lines G and
H. Both the vertices are aligned horizontally, as shown in Figure 1-27.
8. Select the vertex that is joining lines C and D and the vertex that is joining lines J and K.
Both the vertices are aligned horizontally, as shown in Figure 1-27.

Dimensioning the Sketch
Weak dimensions are already applied to the sketch while drawing. You need to
dimension only the angle between lines D and E and lines J and I.
1. Choose the Create defining dimension button.
2. Select lines D and E using the left mouse button; the selected lines turn red in color.
Now, press the middle mouse button to place the dimension close to the vertex where
lines D and E join.
3. Similarly, dimension the angle between lines J and I.
Figure 1-28 shows the sketch after applying dimensions. If your sketch does not have all
dimensions shown in this figure, apply them using the Create defining dimension button.

Modifying the Dimensions
The dimensions that are applied to the sketch need modification in dimension values.
1. Choose the Select items button and then select all dimensions by specifying a
window around them.

Figure 1-27 Sketch with weak dimensions and
constraints
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Figure 1-28 Sketch after dimensioning

2. When the dimensions turn red in color, choose the Modify the values of
dimensions, geometry of splines, or text entities button. The Modify
Dimensions dialog box is displayed.
3. Clear the Regenerate check box and then modify the values of the dimensions. When
you clear this check box, the sketch is not regenerated while you modify the dimensions.
Notice that the dimension you select in the Modify Dimensions dialog box is enclosed
in a yellow box in the graphics window.
4. When all dimensions are modified, choose the Regenerate the section and close the
dialog button from the Modify Dimensions dialog box. A message Dimension
modifications successfully completed is displayed in the Message Area. The completed
sketch is shown in Figure 1-29.

Figure 1-29 Complete sketch with dimensions and constraints
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6. Save the sketch as discussed earlier. After saving the sketch, choose Window > Close
from the menu bar to exit the Sketch mode.
Note
You can also modify dimensions individually. But, individual modification of dimensions is
recommended only when either there is a minor change in the dimension value or when only one
dimension is required to be modified.

Tutorial 3
In this tutorial, you will draw the sketch for the model shown in Figure 1-30. The sketch is
shown in Figure 1-31. For your reference, all entities in the sketch are labeled alphabetically.
(Expected time: 30 min)

Figure 1-30 Model for Tutorial 3

Figure 1-31 Sketch of the model

The following steps are required to complete this tutorial:
a.
b.
c.
d.

Set the working directory and create a new object file.
Draw the sketch using the sketcher tools, refer to Figures 1-32 through 1-35.
Dimension the sketch and then modify the dimensions of the sketch, refer to Figure 1-36
Save the sketch and close the file.

Setting the Working Directory
The working directory was selected in Tutorial 1, and therefore there is no need to select
the working directory again. But if a new session of Pro/Engineer is started, then you
have to again set the working directory by following the steps given next.
1. Open the Navigator by sliding it out. Click on the plus symbol adjacent to the ProE-WF-2.0
folder in the Navigator; the contents of the ProE-WF-2.0 folder are displayed.
2. Now right-click on the c01 folder to display a shortcut menu. From this shortcut menu,
choose the Set Working Directory option; the working directory is set to c01. Close the
Navigator.
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Starting New Object File

2. Enter c01tut3 in the Name edit box. Choose the OK button to enter the sketcher
environment of the Sketch mode.

Drawing the Circles
1. Choose Create circle by picking the center and a point on the circle button
from the Sketcher Tools toolbar and specify the center of the circle.
2. Move the cursor to size the circle and click to complete the circle.
3. Draw another circle whose center is collinear with the center of the previous circle.
Figure 1-32 shows the two collinear circles drawn using the Create circle by picking the
center and a point on the circle button from the Sketcher Tools toolbar.

Drawing the Tangent Lines
1. Choose the Create lines tangent to 2 entities button from the flyout in the
Sketcher Tools toolbar. You are prompted to select the start location on the arc
or a circle.
2. Select the left circle at the top. A rubber-band line appears whose one end is attached to
the circle and the other end is attached to the cursor.
3. Click on the top of the right circle; a tangent that connects the two circles is drawn.
4. Similarly, draw a tangent by selecting the two circles at the bottom.
Figure 1-33 shows the sketch after drawing the tangent lines.

Figure 1-32 The two circles with weak dimensions
and constraints

Figure 1-33 Circles joined by lines and the
tangent constraint applied to them
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1. Choose the Create a new object button from the File toolbar. The New dialog
box is displayed. Select the Sketch radio button from the Type area of the New
dialog box. A default name of the sketch appears in the Name edit box.
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Trimming the Circles
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As evident from Figure 1-33, the tangents that are drawn intersect the circles at the point
where they meet the circle. Therefore, the part of the circle that is not required can be
dynamically trimmed.
1. Choose the Dynamically trim section entities button from the Sketcher Tools
toolbar.
2. Select the two circles individually to trim them at the locations shown in Figure 1-34.
Figure 1-35 shows the two circles after deleting the unwanted portion of the circle.

Figure 1-34 Locations to trim

Figure 1-35 Sketch after trimming

Drawing the Circles
1. Choose the black arrow on the right of the Create circle by picking the center
and a point on the circle button to display the flyout. From this flyout, choose
the Create concentric circle button; you are prompted to select an arc.
2. Select arc P and create circle X concentric to the arc. Similarly, select arc Q to create a
concentric circle Y.
Notice that the two arcs are applied radius dimension whereas the circles are applied
diameter dimension. This is because by default, the arcs are applied radius dimension
and circles are applied diameter dimension.

Dimensioning the Sketch
In order to fully define a sketch, it should be dimensioned.
1. Choose the Create defining dimension button.
2. Select the centers of the two circles and place the dimension at the bottom of the sketch.

Modifying the Dimensions
1. Choose the Select items button.
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2. Select all dimensions by defining a window.

3. When all dimensions turn red in color, choose the Modify the values of
dimensions, geometry of splines, or text entities button; the Modify Dimensions
dialog box is displayed.
4. Clear the Regenerate check box and then modify the values of the dimensions.
You will notice that the dimension you edit in the Modify Dimensions dialog box is
enclosed by a yellow box in the graphics window.
5. When all dimensions are modified, choose the Regenerate the section and close the
dialog button from the Modify Dimensions dialog box; a message Dimension
modifications successfully completed is displayed in the Message Area.
The sketch is completed and is shown in Figure 1-36.

Figure 1-36 The complete sketch with dimensions and constraints
6. Save the sketch as discussed earlier. After saving the sketch, choose Window > Close
from the menu bar to exit the Sketch mode.

Self-Evaluation Test
Answer the following questions and then compare your answers with those given at the
end of this chapter.
1. Dimensions and constraints are automatically applied to a sketch when you draw it. (T/F)
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Note
You can also use CTRL+ALT+A from the keyboard to select all entities and items in the sketch.
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2. In Pro/ENGINEER, you can create lines that are tangent to two circles. (T/F)
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3. If the Intent Manager is on and you draw a line, the cursor snaps to the endpoint of the
previous line. (T/F)
4. You can convert a weak constraint to strong by using the shortcut menu that is displayed
when you right-click on the weak constraint. (T/F)
5. While drawing a circle, first you need to specify its diameter. (T/F)
6. The __________ menu in the menu bar has the Modify option in it.
7. The sketch can be modified by changing its __________.
8. Intent Manager is __________ by default when you enter the Sketch mode. (on/off)
9. In the Sketch mode the tangent constraint is represented by __________ symbol.
10. The Sketch mode file is saved with a __________ file extension.

Review Questions
Answer the following questions:
1. What is the need of Sketch mode in Pro/ENGINEER?
2. What are the four basic steps to create a sketch?
3. What are the various types of lines you can sketch using the buttons available in the
Sketcher Tools toolbar?
4. Why is it important to select the working directory before creating a new file?
5. Write all steps involved in creating a sketch that is accepted by Pro/ENGINEER.
6. You can dynamically modify the geometry of a sketch. (T/F)
7. You can use the Create rectangle button from the Sketcher Tools toolbar to draw a
square. (T/F)
8. The ___________ button is used to apply constraints manually.
9. You cannot undo a previous operation in the sketcher environment. (T/F)
10. You can also use the options in the menu bar to draw a sketch from the Sketch menu.
(T/F)
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Exercises

In this exercise, you will draw the sketch for the model shown in Figure 1-37. The sketch is
shown in Figure 1-38.
(Expected time: 30 min)

Figure 1-37 Solid model for Exercise 1

Figure 1-38 Sketch of the model

Exercise 2
In this exercise, you will draw the sketch for the model shown in Figure 1-39. The sketch is
shown in Figure 1-40.
(Expected time: 30 min)

Figure 1-39 Solid model for Exercise 2

Figure 1-40 Sketch of the model
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Exercise 1
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Exercise 3
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In this exercise, you will draw the sketch for the model shown in Figure 1-41. The sketch is
shown in Figure 1-42.
(Expected time: 30 min)

Figure 1-41 Solid model for Exercise 3

Figure 1-42 Sketch of the model

Exercise 4
In this exercise, you will draw the sketch for the model shown in Figure 1-43. The sketch is
shown in Figure 1-44.
(Expected time: 30 min)

Figure 1-43 Solid model for Exercise 4

Figure 1-44 Sketch of the model

Answers to Self-Evaluation Test
1 - T, 2 - T, 3 - T, 4 - T, 5 - F, 6 - Edit, 7 - dimensions, 8 - on, 9 - T, 10 - .sec
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Creating Sketches in
the Sketch Mode-II
Learning Objectives
After completing this chapter you will be able to:
• Use various options to dimension a sketch.
• Create fillets.
• Place a user-defined coordinate system.
• Create, dimension, and modify splines.
• Create text.
• Scale and rotate entities.
• Copy a sketch.
• Import 2D drawings.
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DIMENSIONING THE SKETCH
In Chapter 1 you have learned how to dimension a sketch using the Normal
option or using its equivalent tool, that is, Create defining dimension button
in the Sketcher Tools toolbar. In this chapter, you will learn the Baseline
option of dimensioning a sketch.
Choose Sketch > Dimension from the menu bar; the cascading menu is
displayed, as shown in Figure 2-1. The options that are available to dimension
a sketch are shown in this figure and are discussed next.

Figure 2-1
Dimensioning
options

Dimensioning a Sketch Using the Baseline Option
In Pro/ENGINEER, the Baseline option of dimensioning is used to create dimensions in
terms of horizontal and vertical location values of an entity with respect to a specified baseline.
This type of dimensioning in a drawing can be used for writing a CNC program to
manufacture a component.
The Baseline option can be used to dimension lines, conics, arcs, and so on. The following
steps explain the procedure to create dimensions using the Baseline option:
1. Choose Sketch > Dimension > Baseline from the menu bar.
2. Select the entity that will act as the baseline (origin or reference). Press the middle mouse
button to place the dimension, the dimension 0.00 is displayed where you place the
dimension. Note that since the location value of the baseline is taken as the origin, the
dimension value of the baseline entity will become 0.00. The dimension values of all
other entities dimensioned with reference to the baseline will be measured from this
origin.
Depending upon the entity selected to act as the baseline, the horizontal or the vertical
dimension value of the location of the entity will be placed. For example, if you select a
vertical line, the value of its location will be placed vertically. Similarly, if you select a
horizontal line, the value of its location will be placed horizontally.
For arcs, circles, and splines there are two options to dimension
using the Baseline option. When you select a circle center or
an arc for baseline dimensioning and press the middle mouse
button, the Dim Orientation dialog box is displayed, as shown
in Figure 2-2. You are prompted to select the dimension
orientation; the dimension is placed according to the
orientation selected.
3. Next, choose the Create defining dimension button from the
Sketcher Tools toolbar. Select the baseline dimension that was
placed earlier and then select the entity to dimension. Now,
press the middle mouse button to place the dimension.

Figure 2-2 The Dim
Orientation dialog box

2-3

The orientation of the dimension will depending upon the baseline dimension and the
entity selected. Figure 2-3 shows a sketch dimensioned using the above-mentioned method.
In this figure, the two baselines are dimensioned using the Baseline option. Therefore,
the dimensions of these lines are displayed as 0.00. The remaining lines are
dimensioned by using the Create defining dimension button by first selecting the baseline
dimension and then the entity to dimension.

Figure 2-3 Baseline dimensioning of a sketch

Replacing the Dimensions of a Sketch Using the Replace
Option
The Replace option is used to replace a dimension from a sketch. To use this option you must
have a dimensioned sketch. The following steps explain the procedure to dimension a sketch
using the Replace option:
1. Choose Edit > Replace from the menu bar, you will be prompted to select a dimension
to be replaced.
2. Select the dimension to be replaced; the selected dimension is erased. Select an entity to
dimension and place the dimension at the desired place. The previous dimension is
replaced by a new dimension.

CREATING FILLETS
In the sketcher environment, you can create two types of fillets.
1. Circular fillets
2. Elliptical fillets

Creating Circular Fillets
A circular fillet is the arc that is used to join two lines, a line and an arc, or two arcs. The fillet
is controlled by its radius or diameter dimension. The resulting fillet will depend on the
location where the elements are selected.
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Figure 2-4 shows two lines that do not join at the corners and Figure 2-5 shows the circular
fillet created between them. The circular fillet that is created is an arc with its endpoints
tangent to the two lines. This is evident from the T symbol that is automatically applied to
the endpoints of the fillet arc.

Figure 2-4 Two lines that do not join

Figure 2-5 Fillet created between the two lines

Figure 2-6 shows two lines that join at the corner and Figure 2-7 shows the circular fillet
created that joins the two lines by an arc. The corner is automatically deleted.

Figure 2-6 Two lines joining at the corner

Figure 2-7 Filleted corner

Figure 2-8 shows two sets of arcs and Figure 2-9 shows the circular fillet created between the
two arcs. The location where you select the arcs to create the fillet is important. The fillet is
created tangent to the selection points on the arcs. Here, the endpoints of the arcs are selected
to create the fillet.
If the points of selection on the two arcs are away from the endpoints of the arcs, then the
fillet is created at the selection points. The portion of the arc that extends beyond the fillet
should be manually deleted or trimmed. This case of creating a fillet is explained in
Figures 2-10 and 2-11.
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Figure 2-8 Two sets of arcs

Figure 2-9 Fillet created by selecting the endpoints

Figure 2-10 Points selected on arcs

Figure 2-11 Filleted arcs

The Create a circular fillet between two entities button in the Sketcher Tools toolbar
is used to create circular fillets. The following steps explain the procedure to create a
circular fillet:
1. Choose the Create a circular fillet between two entities button from the Sketcher Tools
toolbar; you are prompted to select two entities.
2. Select the first entity for filleting by using the left mouse button; the yellow color of the
first entity changes to red. Now, select the second entity. As soon as you select the second
entity, if possible, a fillet is drawn between the two selected entities.
3. Repeat step 2 until you have created all fillets.
Note
You can create a fillet between any two entities except between two parallel lines and between a
centerline and an entity.
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Creating Elliptical Fillets
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An elliptical fillet is the arc in the form of an ellipse that joins two lines, two arcs, or a line and
an arc. The geometry of the elliptical fillet depends on the location where you select the
entities to create a fillet.
The advantage of elliptical fillets over circular fillets is that elliptical fillets have the geometry
of an ellipse. As you know, an ellipse is controlled by dimensions in two directions. Therefore,
when an elliptical fillet is dynamically modified, its geometry can be controlled in either
the x-direction or the y-direction. Hence, the elliptical fillet when modified, results in more
curved geometric shapes than a circular fillet.
Figures 2-12 and 2-13 illustrate the elliptical fillet. Notice, that a strong tangent constraint T
is automatically applied when you create a fillet.

Figure 2-12 Arcs to be filleted

Figure 2-13 Elliptical fillet created

An elliptical fillet is created by choosing the Create an elliptical fillet between two
entities button in the Sketcher Tools toolbar. The following steps explain the
procedure to create elliptical fillets:
1. Choose the black arrow on the right of the Create a circular fillet between two entities
button to display a flyout. Choose the Create an elliptical fillet between two entities
button from this flyout; you are prompted to select two entities.
2. Select the first entity by clicking; the color of the entity changes to red.
3. Select the second entity. As soon as you select the second entity, the elliptical fillet is
created. The shape of the elliptical fillet depends upon the specified points. After the
fillet is created, you are again prompted to select two entities for elliptical fillet.
4. Repeat steps 2 and 3 until you have created all fillets.
When you select an elliptical fillet to dimension, the Ellipse Rad dialog box is displayed, as
shown in Figure 2-14. There are two radio buttons in this dialog box. The X Radius radio

Creating Sketches in the Sketch Mode-II

2-7

CREATING A REFERENCE COORDINATE
SYSTEM
The Create reference coordinate system button in the Sketcher
Tools toolbar is used to create a coordinate system and add it Figure 2-14 Ellipse
to the created sketch. The coordinate system acts as reference Radius dialog box
for dimensioning. You can dimension the splines using the
coordinate system. Thus, it provides you the flexibility to modify the spline points by
specifying different coordinates with respect to the coordinate system.
The user-defined coordinate system is used in blend features to align different sections in a
blend. It is also used in the Assembly mode and Manufacturing mode of Pro/ENGINEER.
The following steps explain the procedure to create a coordinate system:
1. Choose Create reference coordinate system button on the flyout that is displayed when
you choose the black arrow on the right of the Create points button in the Sketcher
Tools toolbar. You are prompted to select the location for the coordinate system. The
coordinate system symbol is attached to the cursor.
2. Place the coordinate system at the desired points on the screen by clicking. The coordinate
system will be placed at as many places as you click in the graphics window. You can end
coordinate system creation by using the middle mouse button.
Note
If you add a coordinate system to a sketch, it must be dimensioned. Unless the coordinate system
is placed at the endpoints of a line, an arc, a spline, or at the center of an arc or a circle. In other
words, a coordinate system must be referenced to an entity in a sketch.

WORKING WITH SPLINES
Splines are curved entities that pass through an infinite number of intermediate points.
Generally, splines are used to define the outer surface of a model. This is because the splines
can provide different shape to curves and the flexibility to modify the surfaces that result
from the splines. Splines find application in automobile and aeroplane body designing.

Creating a Spline
To draw a spline, choose the Create a spline curve button from the Sketcher Tools
toolbar.
The following steps explain the procedure to create a spline:

Evaluation chapter. Logon to www.cadcim.com for more details

button when selected dimensions the elliptical fillet radially in the
X-direction. The Y Radius radio button when selected dimensions the
elliptical fillet radially in the Y-direction.
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1. Choose the Create a spline curve button from the Sketcher Tools toolbar; you are
prompted to select the location for spline.
2. Use the left mouse button to select the start point for the spline. Similarly, select additional
points in the graphics window and a spline will be drawn that passes through the specified
points. All points through which the spline passes are called interpolation points.
Note
If you select the start point of the spline as its end point, then the resulting spline will be in form
of a continuous loop.

Dimensioning of Splines
When a spline is drawn, the weak dimensions are automatically applied to the spline. A
spline can be dimensioned manually in the following ways:
1.
2.
3.
4.
5.

Dimensioning the endpoints.
Radius of curvature dimensioning.
Tangency dimensioning.
Coordinate dimensioning.
Dimensioning the interpolation points.

Dimensioning the Endpoints
To dimension a spline by selecting the endpoints:
1. Choose the Create defining dimension button from the Sketcher Tools toolbar.
2. Select the two endpoints of the spline and place the horizontal or vertical dimension by
pressing the middle mouse button. Figure 2-15 shows a spline that is dimensioned by
selecting the endpoints.

Radius of Curvature Dimensioning
The radius of curvature of a spline can be dimensioned only if its tangency is defined. In
other words, radius of curvature of a spline can be dimensioned only if the spline is tangent
to an entity. For radius of curvature dimensioning of a spline:
1. Choose the Create defining dimension button from the Sketcher Tools toolbar.
2. Select the endpoint of the spline where tangency is defined.
3. Press the middle mouse button to place the dimension. Figure 2-16 shows the radius of
curvature dimensioning of a spline.

Tangency or Angular Dimensioning
A spline can be dimensioned tangentially. This type of dimensioning is also called angular
dimensioning. To angular dimension a spline and a line tangent to it:

Figure 2-15 Endpoint dimensioning
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Figure 2-16 Radius of curvature

1. Choose the Create defining dimension button from the Sketcher Tools toolbar.
2. Select the spline by clicking.
3. Select the entity tangent to the spline by clicking.
4. Select the interpolation point of the spline that is to be dimensioned tangentially.
5. Press the middle mouse button to place the dimension.

Coordinate Dimensioning
The spline can be dimensioned with respect to a user-defined coordinate system. Choose the
Create reference coordinate system button from the flyout in the Sketcher Tools toolbar.
The coordinate system is attached to the cursor. Place the coordinate system in the graphics
window. Now, the spline can be dimensioned with respect to the coordinate system.

Dimensioning the Interpolation Points
A spline can be dimensioned by dimensioning its interpolation points or vertices. This type
of dimensioning is used when the designer wants the spline to be standard for all designs.
This is because the exact curve can be duplicated if the interpolation points or the vertices of
a spline are dimensioned.
Tip: A dimension can be moved by pressing and holding the left mouse button on the
dimension and moving it. The dimension text is replaced by a red colored box. You
can drag the dimension to the desired location in the graphics window and release
the left mouse button to place the dimension at that point.

Modifying a Spline
In Pro/ENGINEER Wildfire 2.0, a spline can be modified in the following ways:
1. Moving the interpolation points of the spline.
2. Adding points to a spline.
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3. Deleting points of a spline.
4. Creating a control polygon and moving its control points.
5. Modifying the dimensions of the spline.
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Moving the Points of the Spline
The position of the interpolation points can be dynamically modified. To modify a spline,
select an interpolation point on the spline and drag it to modify the shape of the spline.
You can also use the dashboard to modify a spline. To invoke the dashboard, select the spline
and hold the right mouse button down to invoke the shortcut menu. Choose the Modify
option from the shortcut menu. The Modify Spline dashboard is displayed at the bottom of
the graphics window with the options and buttons to modify a spline .
The interpolation points of the spline appear in white in the graphics window. Drag the
interpolation points to modify the shape of the spline. Choose from the dashboard to exit it.

Adding Interpolation Points to a Spline
To add interpolation points on a spline, invoke the dashboard. Now, right-click on the spline
to invoke the shortcut menu. Choose the Add Point option; a point is added to the spline
where the spline was selected. The new point appears in white. Note that the Add Point
option is available only when the dashboard is displayed at the bottom of the graphics window.
You cannot increase the length of the spline by adding points before the start point and after
the endpoint of the spline.

Deleting Interpolation Points of a Spline
To delete a point or a vertex, invoke the dashboard. Now, select the vertex and hold down the
right mouse button to invoke the shortcut menu. Choose the Delete Point option from the
shortcut menu. The selected point is deleted. You can continue deleting vertices or points
from a spline until only two end points are left in the spline.

Creating a Control Polygon and Moving its Control Points
When you draw a spline, it is associated with a control frame. The vertices of its frame
are called control points. To create a control polygon, choose the Modify spline
using control points button from the dashboard. The control polygon is displayed in
the graphics window. The control points of this polygon can be moved by dragging to modify
the spline shape.

Modifying the Dimensions of the Spline
The shape of the spline is controlled by the position of its interpolation points. Hence by
modifying the dimensions, the position of the interpolation points are changed, which results in
modification of the shape of the spline.
Tip: To dynamically modify the shape of the sketch, you need to select an entity of the
sketch and drag the mouse to modify the sketch. Remember that if the selected entity
is constrained then you cannot modify it. You can modify it only after disabling the
constraints.

Creating Sketches in the Sketch Mode-II
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WRITING TEXT IN SKETCHER ENVIRONMENT

In the sketcher environment, the text is written using the Create text as a part of a
section button from the Sketcher Tools toolbar. The following steps explain the
procedure to write text in the sketcher environment:
1. Choose the Create text as a part of a section button from the Sketcher Tools toolbar;
you are prompted to select the start point of line to determine the text height and
orientation.
2. Specify the start point on the screen by clicking; you are prompted to select the second
point of line to determine the text height and orientation.
3. Note that to write the text upright, the second point should be above the start point and
in a straight line. If the second point is below the start point, the text will be written
upside down. Specify the second point on the screen by clicking; the Text dialog box is
displayed, as shown in Figure 2-17.

Figure 2-17 The Text dialog
After specifying the second point, a construction line is drawn having height equal to the
distance between the two points. The height and orientation of the text depends on the
height and angle of the construction line. If the construction line is drawn at an angle,
then the text is written at that angle.
4. In the Text Line edit box, enter the text, which can be up to 79 characters. As you enter
the text, the text is displayed dynamically in the graphics window. You can choose the
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There are various instances when a designer needs a text command to write text on the
model. For example, for creating a label, model number, company name, and so on. In
Pro/ENGINEER, you can write this text in the sketcher environment.
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desired font of the text from the Font drop-down list. The aspect ratio and the slant
angle of the text can be controlled by using the slider bars.
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5. Choose the OK button in the Text dialog box to exit it.
Note
In later chapters of this book, you will learn that to enter the sketcher environment there are
other methods also, other than entering through the Sketch mode.

SCALING AND ROTATING ENTITIES
The sketches can be scaled or rotated by using the Scale and rotate selected entities
button from the Sketcher Tools toolbar. To invoke this button, select the sketch and
then choose the arrow on the right of the Mirror selected entities button. This button
is available on the flyout that is displayed. After choosing this tool button, the sketch that is
composed of various entities now acts as a single entity. The sketch appears orange in color
and is enclosed in a boundary box, as shown in Figure 2-18.

Figure 2-18 Selected entities enclosed in a boundary box with three handles
There are three handles that facilitate in scaling and rotating the selected sketch. The rotate
handle is used to dynamically rotate the selected entities. The scale handle is used to
dynamically scale the selected entities. The base point handle is used to pick the sketch and
place it at any other location in the graphics window. To change the location of any of the
three handles, right-click on the handle. The handle symbol is attached to the cursor. Place
the symbol at the desired location. The following steps explain the procedure to scale and
rotate a sketch:
1. Select the sketch to be rotated and scaled, and then choose the black arrow on the right
of the Mirror selected entities button from the Sketcher Tools toolbar.
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3. To dynamically rotate the sketch, select the rotate handle and
then move the cursor; the sketch is rotated as you move the
cursor. You can also enter the rotation angle in the Rotate edit
box.

Figure 2-19 The Scale
Rotate dialog box

To scale the sketch, select the scale handle and then move the cursor. As you move the
cursor, the sketch is scaled dynamically in the graphics window. You can also enter the
scale value in the Scale edit box.
4. After the sketch is rotated and scaled, choose the Accept the changes and close the
dialog button in the Scale Rotate dialog box.

COPYING SKETCHED ENTITIES IN SKETCH MODE
The Make a copy of selected entities button in the Sketcher Tools toolbar is used to
copy the entities in the sketcher environment. To invoke this button, select the sketch
and then choose the arrow on the right of the Mirror selected entities button. Choose
the Make a copy of selected entities button from the flyout that is displayed. The Scale Rotate
dialog box is displayed. Using this dialog box, you can simultaneously copy, scale and rotate the
selected entities. The following steps explain the procedure to copy the selected entities:
1. Select the entities to be copied and then choose the black arrow on the right of the
Mirror selected entities button from the Sketcher Tools toolbar. From the flyout, choose
the Make a copy of selected entities button.
The copy of the selected entity is placed at the top left corner in the graphics window.
This copy appears red in color. There are three handles in the copied entities that facilitate
in sizing and orienting them. Figure 2-20 shows the copied sketch enclosed in a boundary
with the three handles.
The Scale Rotate dialog box is also displayed. Use this dialog box to specify the scale
factor and the rotation angle.
2. Select the base point handle; the copied entities are attached to the cursor. Place the
entities where needed.
3. Finally, choose the Accept the changes and close the dialog button in the Scale Rotate
dialog box.

IMPORTING 2D DRAWINGS IN THE SKETCH MODE
The two-dimensional (2D) drawings when opened in the sketcher environment can be saved
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2. From the flyout, choose the Scale and rotate selected entities
button; the Scale Rotate dialog box is displayed, as shown in
Figure 2-19. This dialog box contains the Scale and Rotate
edit boxes. The sketch can be scaled and rotated dynamically
or by entering a value in these edit boxes.
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Figure 2-20 Original entities and the copied entities with three handles
in the .sec format. The .sec file can then be converted to a solid model. The Data from file
option in the Sketch menu in the menu bar is used to import the 2D sketches. This option
saves time in drawing the same or similar section again. The file formats from which the data
can be imported are shown in Figure 2-21.

Figure 2-21 File formats
When you choose Sketch > Data from file from the menu bar, the Open dialog box is displayed,
as shown in Figure 2-22. Use this dialog box to select and open the file.
In the Open dialog box, if you select a drawing file that is created in the Drawing mode of
Pro/ENGINEER Wildfire 2.0, the draft entities in that file are imported. The selected drawing
is opened in a sub window. You are prompted to select the entities to copy from the sub window.
Select the draft entities and then press the middle mouse button. The selected entities are
enclosed in a boundary and the Scale Rotate dialog box is displayed. Use this dialog box to
set the scale and orientation of the sketch. Note that if the .drw file does not consist of draft
entities, no data is imported.
In the Open dialog box, if you select a .sec file that is created in the sketcher environment, the
sketch is either displayed in the graphics window enclosed in a boundary or is directly placed
in the graphics window. If there are no entities in the current sketcher environment, the
selected sketch will be automatically placed in the graphics window. In case, there are some
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Figure 2-22 The Open dialog box
entities present in the current sketcher environment, the selected sketch is enclosed in a
boundary and the Scale Rotate dialog box is displayed. Use this dialog box to set the scale
and orientation of the sketch.
The section imported using the Data from file option in the current sketch is an independent
copy. The imported section is no longer associated with the source section. The units,
dimensions, grid parameters, and accuracy are acquired from the current sketch.
Tip: The display of vertices of the section, the display of dimensions, and the display
of constraints can be turned on or off from the Sketcher toolbar. This toolbar is in the
Top Toolchest.

TUTORIALS
Tutorial 1
In this Tutorial you will import an existing sketch that you had drawn in Tutorial 3 of
Chapter 1. After placing the sketch, draw the keyway, as shown in Figure 2-23.
(Expected time: 15 min)
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Figure 2-23 Sketch for Tutorial 1
The following steps are required to complete this tutorial:
a.
b.
c.
d.
e.
f.

Start Pro/ENGINEER Wildfire 2.0.
Set the working directory and create a new object file.
Import the section by using the Data from file option, refer to Figure 2-24.
Draw the keyway and dimension it, refer to Figures 2-25 and 2-26.
Modify the dimensions, refer to Figure 2-27.
Save the sketch and exit the sketcher environment.

Starting Pro/ENGINEER
1. Start Pro/ENGINEER Wildfire 2.0 by double-clicking on the Pro/ENGINEER icon on
the desktop of your computer or by using the Start menu.

Setting the Working Directory
When the Pro/ENGINEER session is started, the first task is to set the working directory.
As mentioned earlier, working directory is a directory on your system where you can save
the work done in the current session of Pro/ENGINEER. You can set any directory
existing on your system as the working directory. Since this is the first tutorial of this
chapter, you need to create a folder named c02 in the C:\ProE-WF-2.0 folder, if it does not
exist.
1. Choose the Set Working Directory option from the File menu. The Select Working
Directory dialog box is displayed.
2. Browse and select C:\ProE-WF-2.0.
3. Choose the New Directory button in the Select Working Directory dialog box. The
New Directory dialog box is displayed.

Creating Sketches in the Sketch Mode-II
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4. Type c02 in the New Directory edit box. Choose OK from the dialog box. You have
created a folder named c02 in C:\ProE-WF-2.0.

Starting a New Object File
1. Choose the Create a new object button from the File toolbar; the New dialog box
is displayed. Select the Sketch radio button from the Type area of the New dialog box. A
default name of the sketch appears in the Name edit box.
2. Enter c02tut1 in the Name edit box. Choose the OK button.
You are in the sketcher environment of the Sketch mode. When you enter the sketcher
environment, the Navigator is displayed to the left in the graphics window. Slide in the
Navigator by clicking on the sash present on its right edge. Now, the drawing area is
increased.

Importing the Section
1. Choose Sketch > Data from file from the menu bar; the Open dialog box is displayed
with the working directory as the current directory.
2. Choose the Up One Level button and then open the c01 directory. Make sure
that the sketch (*.sec) option is selected in the Type drop-down list. Select
c01tut3.sec and choose the Open button from the Open dialog box.
The sketch is placed in the graphics window, as shown in Figure 2-24.

Figure 2-24 Sketch imported and placed in the current file
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5. Choose OK from the Select Working Directory dialog box. You have set the working
directory to C:\ProE-WF-2.0\c02.
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Drawing the Keyway
To create the keyway, you will sketch the keyway and then the portion of the circle that
lies between the horizontal lines will be removed.
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1. Choose the Create 2 points line button from the Sketcher Tools toolbar.
2. Draw the keyway, as shown in Figure 2-25; the weak dimensions and constraints are
automatically applied to the sketch of the keyway.
The horizontal lines of the keyway and the circle intersect at the points where the lines
meet the circle. The intersection points are displayed in orange color. The portion of the
circle that lies between the two horizontal lines of the keyway needs to be deleted from
the circle.
3. Choose the Zoom In button from the View toolbar in the Top Toolchest; the
cursor is converted into a magnifying glass symbol.
4. Draw a window around the keyway to zoom in. Now, the display of the keyway is enlarged.
5. Choose the Dynamically trim section entities button from the Sketcher Tools
toolbar.
6. Click to select the part of the circle that lies between the two intersection points. The
part of the circle that was between the two horizontal lines is deleted.
7. Choose the Refit object to fully display it on the screen button from the View
toolbar to view the full sketch.

Dimensioning the Keyway
The dimensions that will be applied to the keyway are shown in Figure 2-25.
1. Choose the Create defining dimensions button from the Sketcher Tools toolbar.
2. Dimension the keyway, as shown in Figure 2-26.

Modifying the Dimensions
The dimensions of the keyway will be modified to the given dimension values.
1. Select the three dimensions of the keyway by using CTRL+left mouse button.
2. Choose the Modify the values of dimensions, geometry of splines, or text
entities button from the Sketcher Tools toolbar. The Modify Dimensions dialog
box is displayed.
3. Clear the Regenerate check box and then modify the values of the dimensions. When
you clear the check box, the sketch does not regenerate as you modify the dimensions.

Figure 2-25 Sketch of the keyway with weak
dimensions and constraints
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Figure 2-26 Sketch after dimensioning the
keyway

The dimension that you edit in the Modify Dimensions dialog box is enclosed in a yellow
box in the sketch.
4. Modify all dimensions. Refer to Figure 2-23 for dimension values.
5. After the dimensions are modified, choose the Regenerate the section and close the
dialog button from the Modify Dimensions dialog box. The message Dimension
modifications successfully completed is displayed in the Message Area.
The sketch after modifying the dimension values of the sketch is shown in Figure 2-27.

Figure 2-27 Sketch after modifying the dimensions
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Saving the Sketch
You have to save the sketch because you may need the sketch later.
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1. Choose the Save the active object button from the File toolbar. The Save Object
dialog box is displayed with the name of the sketch that you had entered earlier.
2. Choose the OK button; the sketch is saved.
3. After saving the sketch, choose Window > Close from the menu bar to exit the Sketch
mode.

Tutorial 2
In this tutorial, you will draw the sketch for the model shown in Figure 2-28. The sketch is
shown in Figure 2-29.
(Expected time: 30 min)

Figure 2-28 Model for Tutorial 2

Figure 2-29 Sketch of the model

The following steps are required to complete this tutorial:
a.
b.
c.
d.
e.

Set the working directory and create a new object file.
Draw the sketch using sketcher tools, refer to Figures 2-30 through 2-33.
Apply the required constraints and dimensions to the sketched entities, refer to Figure 2-35.
Modify the dimensions of the sketch and then save the sketch, refer to Figure 2-36.
Exit the Sketch mode.

Setting the Working Directory
The working directory was selected in Tutorial 1, and therefore there is no need to select
the working directory again. But if a new session of Pro/Engineer is started, then you
have to again set the working directory by following the steps given next.
1. Open the Navigator by clicking the top arrows on the left edge of the Pro/ENGINEER
main window; the Navigator slides out.
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2. Click on the plus symbol adjacent to the ProE-WF-2.0 folder in the Navigator; the
contents of the ProE-WF-2.0 folder are displayed.

4. Close the Navigator by clicking the sash on the right edge of the Navigator. The Navigator
slides in.

Starting a New Object File
1. Start a new object file in the Sketch mode. Name the file as c02tut2.

Drawing the Sketch
To draw the outer loop, you need to draw three circles and then draw lines tangent to the
three circles.
1. Choose the Create circle by picking the center and a point on the circle button.
Draw the three circles, as shown in Figure 2-30.
2. Choose the black arrow on the right of the Create 2 points line button to display
a flyout. Choose the Create lines tangent to 2 entities button from this flyout.
3. Select the left circle at the top and then select the middle circle at the top. A tangent is
drawn from the top of the left circle to the top of the middle circle.
4. Select the right circle at the top and the middle circle at the top. A tangent is drawn from the
top of the right circle to the top of the middle circle.
5. Similarly, using the Create lines tangent to 2 entities button, draw the other tangents
from the bottom of the circles, as shown in Figure 2-31.

Figure 2-30 Three circles with weak dimensions
and constraints

Figure 2-31 Lines joining the three circles
with weak dimensions
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3. Now right-click on the c02 folder to display a shortcut menu. From this shortcut menu,
choose the Set Working Directory option. The working directory is set to c02.
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Trimming the Circles
The inner portions of the circles are not required. Therefore, you need to trim them.
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1.

Choose the Dynamically trim section entities button from the Sketcher Tools toolbar.

2. Bring the cursor close to the right portion of the left circle. The right part of the
circle turns cyan in color. Click on the right portion of the circle to delete it.
3. Similarly, trim the parts of the middle and the right circle that are not required. The
sketch after trimming the circles is shown in Figure 2-32.

Drawing the Circles
1. Choose the black arrow on the right of the Create circle by picking the center and a
point on the circle button to display the flyout. From this flyout, choose the Create
concentric circle button. You are prompted to select an arc.
Tip: While drawing a concentric circle, sometimes the circle snaps to the other circle
or arc and it becomes difficult to draw a circle of the size you need. The snapping of
the circle to the other circle or arc can be disabled. While drawing the circle when the
circle snaps to the other circle, use TAB+right-click to disable the snapping or to
disable the equal radii constraint that the system tends to apply.
2. Click on the left arc. Notice that when you move the mouse, a circle appears. Select a
point inside the sketch to complete the circle. Press the middle mouse button.
Note
You may need to zoom in to select the top arc in the next step.
3. Click on the top arc. Notice that when you move the mouse a circle appears. Select a
point inside the sketch to complete the circle. Press the middle mouse button to end
circle creation.
4. Click on the right arc. Notice that when you move the mouse a circle appears. When R2
symbol appears on the circle, click to complete the circle. Press the middle mouse button
to end circle creation.
The R2 symbol appears on both the left and the right circle indicating that their radii are
same. The constraint symbols like R1 or R2 vary from sketch to sketch.
The sketch after drawing the three circles is shown in Figure 2-33.

Applying the Constraints
1. Choose the Impose sketcher constraints on the section button from the Sketcher
Tools toolbar. The Constraints dialog box is displayed.
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Figure 2-32 Sketch after trimming the circles

Figure 2-33 Sketch after drawing the three circles

2. Choose the Create Equal Lengths, Equal Radii, or Same Curvature constraint
button from the Constraints dialog box.
3. Select the left arc and then select the right arc to apply the equal radius constraint.
4. Select the left circle and the right circle to apply the equal radius constraint.
5. Use the CTRL+middle mouse button to zoom in and now select the top arc and the
bottom arc to apply the equal radius constraint. If the constraint is already applied, the
Resolve Sketch dialog box is displayed, as shown in Figure 2-34.

Figure 2-34 The Resolve Sketch dialog box
6. Select the third constraint in the Resolve Sketch dialog box and choose the Delete button.
The constraint that was conflicting is deleted.
7. Choose the Make two lines parallel constraint button from the Constraints dialog
box.
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8. Click to select the tangent line that connects the left circle and the middle circle at the top.
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9. Click to select the tangent line that connects the right circle and the middle circle at the
bottom.
It is evident from the parallel constraint symbol that the parallel constraint is applied to
the two tangent lines in the sketch.
10. Similarly, apply the parallel constraint to the other set of tangent lines. The sketch after
applying the constraints is shown in Figure 2-35.
11. Choose the Refit object to fully display it on the screen button from the View
toolbar to view the full sketch in the graphics window.

Dimensioning the Sketch
Pro/ENGINEER applies the weak dimensions to the sketch automatically. These
dimensions are not the dimensions that are needed because these dimensions will not
help to machine the model. Therefore, you will dimension the sketch with the dimensions
that will be used to machine the model.
1. Choose the Create defining dimensions button from the Sketch Tool toolbar.
2. Select the center of right and left circles; the centers of the circles turn red in color. Now,
using the middle mouse button, place the dimension below the sketch.
The rest of the weak dimensions are needed and therefore they will be modified.

Modifying the Dimensions
All constraints and dimensions are applied to the sketch and now dimensions will be
modified.
1. Select all dimensions using CTRL+ALT+A.
2. Choose the Modify the values of dimensions, geometry of splines, or text
entities button. The Modify Dimensions dialog box is displayed.
3. Clear the Regenerate check box and then modify the values of the dimensions. When
you clear the check box, the sketch does not regenerate as you modify the dimensions.
The dimension that you edit in the Modify Dimensions dialog box is enclosed in a yellow
box in the sketch.
4. Modify all dimensions. Refer to Figure 2-29 for dimension values.
5. After the dimensions are modified, choose the Regenerate the section and close the
dialog button from the Modify Dimensions dialog box. The message Dimension
modifications successfully completed is displayed in the Message Area.
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Figure 2-35 Sketch with constraints

Figure 2-36 Sketch after modifying the dimensions

Saving the Sketch
1. Choose the Save the active object button from the File toolbar and save the sketch.

Exiting the Sketch Mode
1. After saving the sketch, choose Window > Close from the menu bar to exit the Sketch
mode.

Tutorial 3
In this tutorial, you will draw the sketch for the model shown in Figure 2-37. The sketch is
shown in Figure 2-38.
(Expected time: 30 min)

Figure 2-37 Model for Tutorial 3

Figure 2-38 Sketch of the model

The following steps are required to complete this tutorial:
a.

Set the working directory and create a new object file.
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The sketch after modifying the dimension values is shown in Figure 2-36.
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b.
c.
d.
e.
f.
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Draw the sketch using sketcher tools, refer to Figures 2-39 and 2-40.
Apply fillets at two corners of the sketch, refer to Figures 2-41 and 2-42.
Dimension the sketch, refer to Figure 2-43.
Modify dimensions of the sketch, refer to Figure 2-44.
Save the sketch and exit the Sketch mode.

Setting the Working Directory
The working directory was selected in Tutorial 1, and therefore there is no need to select
the working directory again. But if a new session of Pro/Engineer is started, then you
have to again set the working directory by following the steps given next.
1. Open the Navigator by clicking the top arrows on the left edge of the Pro/ENGINEER
main window; the Navigator slides out.
2. Click on the plus symbol adjacent to the ProE-WF-2.0 folder in the Navigator. The
contents of the ProE-WF-2.0 folder are displayed.
3. Now right-click on the c02 folder to display a shortcut menu. From this shortcut menu,
choose the Set Working Directory option; the working directory is set to c02.
4. Close the Navigator by clicking the top arrows on the right edge of the Navigator; the
Navigator slides in.

Starting a New Object File
1. Start a new object file in the Sketch mode. Name the file as c02tut3.

Drawing the Sketch
1. Choose the Create 2 points line button from the Sketcher Tools toolbar.
2. Draw the lines, as shown in Figure 2-39.
3. Choose the Create an arc by 3 points or tangent to an entity at its endpoint
button from the Sketcher Tools toolbar.
4. Select the endpoint of the left vertical line as the start point of the arc. Complete the arc
at the endpoint of the right vertical line.
5. Choose the black arrow on the right of the Create circle by picking the center
and a point on the circle button to display the flyout. From this flyout, choose
the Create concentric circle button; you are prompted to select an arc.
6. Click on the arc; a red rubber-band circle appears. Size the circle by moving the cursor
and click to complete it.
The sketch after drawing the circle is shown in Figure 2-40.

Figure 2-39 Lines in the sketch with the
dimensions turned off for clarity
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Figure 2-40 Sketch after drawing the arc and the
circle

Note
Choose the Toggle display of dimensions on/off button from the Sketcher toolbar in the Top
Toolchest to turn the dimensions on or off.
Pro/ENGINEER does not have options like midpoint, endpoint, or center of. However, while
drawing a sketch, these options are applied in the form of weak constraints as you sketch. For
example, endpoint of any entity snaps the cursor when a new entity is to be drawn. The middle
point constraint appears when you approximately bring the cursor near to the middle point of
the line to draw a line.

Filleting the Corners
1. Choose the Create a circular fillet between two entities button from the Sketcher
Tools toolbar. You are prompted to select the two entities to be filleted. The
corners that you need to fillet are shown in Figure 2-41.
2. Select the two entities one by one using the left mouse button. The corner of the selected
lines are filleted. Fillet all required corners shown in Figure 2-41.
The sketch after filleting is shown in Figure 2-42.

Applying the Constraints
1. Choose the Impose sketcher constraints on the section button from the Sketcher Tools
toolbar. The Constraints dialog box is displayed.
2. Choose the Create Equal Lengths, Equal Radii, or Same Curvature constraint button
from the Constraints dialog box.
3. Click to select the fillets and apply the equal constraint to all fillets.
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Figure 2-41 Fillet corners

Figure 2-42 Sketch after filleting

Dimensioning the Sketch
The weak dimensions are applied to the sketch automatically. These are not the required
dimensions and therefore you need to manually dimension the sketch.
1. Choose the Create defining dimensions button from the Sketch Tools toolbar.
2. Dimension the sketch, as shown in Figure 2-43.

Modifying the Dimensions
You need to modify the dimension values that are assigned to the sketch.
1. Select all dimensions using CTRL+ALT+A.
2. Choose the Modify the values of dimensions, geometry of splines, or text entities
button. The Modify Dimensions dialog box is displayed.
3. Clear the Regenerate check box and then modify the values of the dimensions. When
you clear the check box, the sketch does not regenerate as you modify the dimensions.
The dimension that you edit in the Modify Dimensions dialog box is enclosed in a yellow
box in the sketch.
4. Modify all dimensions. Refer to Figure 2-38 for dimension values.
5. After the dimensions are modified, choose the Regenerate the section and close the
dialog button from the Modify Dimensions dialog box.
The sketch after modifying the dimension values is shown in Figure 2-44.

Figure 2-43 Sketch after dimensioning
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Figure 2-44 Sketch after modifying the dimensions

Saving the Sketch
1. Choose the Save the active object button from the File toolbar and save the sketch.

Exiting the Sketch Mode
1. Choose Window > Close from the menu bar to exit the Sketch mode.

Self-Evaluation Test
Answer the following questions and then compare your answers with those given at the
end of this chapter.
1. You can increase the length of the spline by adding points before the start point and after
the endpoint of the spline. (T/F)
2. While copying sketched entities, the Scale Rotate dialog box is also displayed. (T/F)
3. When you modify a weak dimension it becomes strong. (T/F)
4. You can dimension the length of a centerline. (T/F)
5. The font of the text written in the sketcher environment is fixed and cannot be modified.
(T/F)
6. The __________ of a spline can be dynamically modified.
7. The __________ dialog box is used to modify dimensions.
8. The display of dimensions and constraints can be turned on/off by choosing the __________
and __________ buttons respectively from the Sketcher toolbar.
9. The __________ button is used to rotate selected entities.
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10. You can delete the entities by selecting them and then using the __________ key on the
keyboard.
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Review Questions
Answer the following questions:
1. How many handles are displayed in the graphics window while scaling and rotating
entities?
(a) one
(c) three

(b) two
(d) four

2. Which of the following mouse buttons is used to place the dimension?
(a) left
(c) right

(b) middle
(d) mouse is not used for dimensioning

3. Which of the following is the default font for the text in the sketcher environment?
(a) font
(c) font3d

(b) filled
(d) isofont

4. Which of the following toolbar is used to toggle the display of dimensions and constraints
in the sketcher environment?
(a) Sketcher Tools
(c) File

(b) Sketcher
(d) Edit

5. In which type of dimensioning the Dim Orientation dialog box is displayed while
dimensioning the arcs and circles?
(a) Normal
(c) Baseline

(b) Perimeter
(d) None of the above

6. While placing a section in a new sketch, use the right mouse button to place the section.
(T/F)
7. Elliptical fillets can be created in Pro/Engineer . (T/F)
8. While creating text in the sketcher environment, you need to draw a construction line
that will define the height of the text. (T/F)
9. You can modify the dimensions dynamically. (T/F)
10. The modification of a spline is possible by moving its interpolation points. (T/F)
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Exercises

In this exercise, you will draw the sketch for the model shown in Figure 2-45. The sketch is
shown in Figure 2-46.
(Expected time: 30 min)

Figure 2-45 Solid model for Exercise 1

Figure 2-46 Sketch of the model

Exercise 2
In this exercise, you will draw the sketch for the model shown in Figure 2-47. The sketch is
shown in Figure 2-48.
(Expected time: 15 min)

Figure 2-47 Solid model for Exercise 2

Figure 2-48 Sketch of the model

Exercise 3
In this exercise, you will draw the sketch for the model shown in Figure 2-49. The sketch is
shown in Figure 2-50.
(Expected time: 30 min)
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Exercise 1
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Figure 2-49 Solid model for Exercise 3

Figure 2-50 Sketch for the model

Answers to the Self-Evaluation Test
1 - F, 2 - T, 3 - T, 4 - F, 5 - F, 6 - shape, 7 - Modify Dimensions, 8 - Toggle display of
dimensions on/off, Toggle display of constraints on/off, 9 - Scale and rotate selected entities,
10 - DELETE.

